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免责声明

本文件所载资料仅供一般信息性参考，并不构成提出要约、招揽、邀请或建议以购买或出售任何期
货合约或其他产品，亦不构成提出任何投资建议或任何形式的服务。本文件并非针对亦不拟分派给
任何其法律或法规不容许的司法权区或国家的人士或实体又或供其使用，也非针对亦不拟分派给任
何会令香港交易及结算所有限公司（「香港交易所」）及香港期货交易所有限公司（「期交所」）
（统称「该等实体」，各称「实体」）或其任何联属公司又或此等公司所营运的任何公司须受该司
法权区或国家任何注册规定所规管的人士或实体又或供其使用。

本文件概无任何章节或条款可视为对任何该等实体带来任何责任。任何在期交所执行的期货合约，
其有关交易、结算和交收的权利与责任将完全取决于期交所及相关结算所的适用规则以及香港的适
用法律、规则及规例。

尽管本文件所载资料均取自认为是可靠的来源或按当中内容编备而成，该等实体概不就有关资料或
数据就任何特定用途而言的准确性、有效性、时效性或完备性作任何保证。若资料出现错漏或其他
不准确又或由此引起后果，该等实体及其营运的公司概不负责或承担任何责任。本文件所载资料乃
按「现况」及「现有」的基础提供，资料内容可能被修订或更改。有关资料不能取代根据阁下具体
情况而提供的专业意见，而本文件概不构成任何法律意见。该等实体对使用或依赖本文件所提供的
资料而直接或间接产生的任何损失或损害概不负责或承担任何责任。

中华交易服务中国120指数期货额外免责声明
中华交易服务中国120指数(「中华120指数」)由中证指数有限公司(「中证指数」)代表中华证券交
易服务有限公司(「中华交易服务公司」) 计算及／或发布。中证指数、中华交易服务公司对指数及
／或其相关资料的准确性、完整性、及时性及适用性不作任何明示或暗示的担保。 在任何情况下，
中证指数、中华交易服务公司对任何人因使用指数及／或其相关资料而遭受的任何损失均不承担责
任。

香港交易所脉搏微信号

Apple Store Google Play

小米 360

期货期权资讯应用程序



截至  2025年4月30日

股票指数 份月度表现
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行业指数与恒生指数 / 恒生国企指数比较 中华120与具中国背景指数比较

股票指数期货讯息代码

数据来源：彭博资讯

资料只供参考

2025年4月
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截至  2025年4月30日

恒生指数期货及期权

股票指数期货及期权
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数据来源：香港交易所
* 未平仓合约与上年年底比较
资料只供参考

恒生指数期货 (年度变动) 恒生指数期权(年度变动)

恒生指数期货(月度变动) 恒生指数期权(月度变动)
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恒生指数产品 

(2025 vs 2024)
日均成交量 未平仓合约*

恒生指数期货 145,167 (+3%) 101,546 (-15%)

小型恒生指数期货 120,903 (+25%) 12,472 (-11%)

恒生指数期权 17,921 (-9%) 68,732 (-1%)

小型恒生指数期权 15,009 (-14%) 31,199 (+63%)

恒生指数期货期权 3,452 (-23%) 47,594 (-3%)

恒生波幅指数期货 0 (-) 0 (-)

恒生股息指数期货 28 (-49%) 2,581 (+63%)



恒生指数期货及期权

股票指数期货及期权
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数据来源：香港交易所、彭博资讯
* 不包括佣金，所有数据已港币结算
资料只供参考

恒指及其五大成份股表现恒指与恒指波幅指数价格比较

恒指期权月终未平仓量分布

截至  2025年4月30日

恒生指数

 指数包括市值最大及成交最活跃，

 并在香港上市的股票

 指数水平  22,119.41 (于2025年4月30日)

 指数波动性 (30日 历史波幅)  28.1

 指数全日平均范围值  415.54 (2025年4月)

 与恒生国企指数的相关系数(2025)  0.994

恒生指数期货

 合约乘数  每指数点50港元

 名义值 (每份合约)  111万港元 (于2025年4月30日)

证券交易费用*

 印花税  不适用

 交易费用  HK$10 / 合约

 证监会徵费  HK$0.54 / 合约

 佣金  可议

 保证金 (截至2025年4月28日)  HK$123,050

 指数简介
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恒生国企指数期货及期权

股票指数期货及期权
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数据来源：香港交易所
* 未平仓合约与上年年底比较
资料只供参考

恒生国企指数期货 (年度变动) 恒生国企指数期权(年度变动)

恒生国企指数期货(月度变动) 恒生国企指数期权(月度变动)

截至  2025年4月30日
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恒生国企指数产品 

(2025 vs 2024)
日均成交量 未平仓合约*

恒生国企指数期货 176,337 (-6%) 246,306 (-7%)

小型恒生国企指数

期货
12,358 (+21%) 2,964 (-34%)

恒生国企指数期权 19,962 (-35%) 289,726 (+5%)

小型恒生国企指数

期权
3,254 (-19%) 21,085 (+46%)

恒生国企指数期货

期权
42,820 (+4%) 798,848 (+27%)

恒生国企股股息指

数期货
471 (-62%) 35,714 (+37%)



恒生国企指数期货及期权

股票指数期货及期权
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数据来源：香港交易所、彭博资讯
* 不包括佣金，所有数据已港币结算
资料只供参考

恒生国企指数及其五大成份股表现

恒生国企指数期权月终未平仓量分布

恒生指数与恒生国企指数表现

截至  2025年4月30日

恒生中国企业指数

指数包括最大及成交最活跃的H 股，

提供高度的H股市值涵盖率

 指数水平  8,076.26 (于2025年4月30日)

 指数波动性 (30日 历史波幅)  30.7

 指数全日平均范围值  170.42 (2025年4月)

与恒指、中华120的相关系数 (2025)  0.994,0.978

与沪深300、富时A50的相关系数

(2025)
 0.833,0.8

恒生国企指数期货

 合约乘数  每指数点50港元

 名义值 (每份合约)  40万港元 (于2025年4月30日)

证券交易费用*

 印花税  不适用

 交易费用  HK$3.5 / 合约

 证监会徵费  HK$0.54 / 合约

 佣金  可议

 保证金 (截至2025年4月28日)  HK$47,600

 指数简介
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每周恒指及国企指数期权表现
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数据来源：香港交易所
* 不包括佣金，所有数据以港币结算
资料只供参考

每周恒指及国企指数期权成交量

管理短期风险的投资工具

截至  2025年4月30日
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每周恒指及国企及科技指数认沽期权

成交量

（合约张数）

每周恒指期权
 合约乘数  每指数点50港元

 流通量提供者
 ABN, BNP, Citadel, Eclipse, IMC, Optiver, 

Susquehanna, Yue Kun

证券交易费用*
 印花税  不适用

 交易费用  HK$10 / 合约

 证监会徵费  HK$0.54 / 合约

 佣金  可议

每周国企指数期权
 合约乘数  每指数点50港元

 流通量提供者
 ABN, Citadel, Eclipse, IMC, Optiver, 

Susquehanna

证券交易费用*
 印花税  不适用

 交易费用  HK$3.5 / 合约

 证监会徵费  HK$0.54 / 合约

 佣金  可议

每周科指期权
 合约乘数  每指数点50港元

 流通量提供者  ABN, Eclipse, IMC, Optiver, Susquehanna

证券交易费用*
 印花税  不适用

 交易费用  HK$5 / 合约^

 证监会徵费  HK$0.54 / 合约

 佣金  可议

^交易费用折扣优惠HK$2.5，直至另行通知



个别股票期货及期权

股票期货及期权
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数据来源：香港交易所
* 未平仓合约与上年年底比较
资料只供参考

股票期权（年度变动）股票期货（年度变动）

股票衍生品数目

股票期货 98

股票期权 132

股票期货

• 产品
➢ A-股交易所买卖基金期货共三种合
约
➢共98只股票期货合约

最近及未来发展

股票期权

• 产品
➢ A-股交易所买卖基金期权共三种合
约
➢共132只股票期权合约 (其中10只
为每周股票期权^)

• 市场庄家 (MMs)

➢共三种市场庄家 (PMM/ CQMM/ 

QRMM)

➢持续报价庄家提供50系列

股票期货（月度变动） 股票期权（月度变动）

股票衍生品日均成交量 (2025 vs 2024) 日均成交量 未平倉合約*

股票期貨 10,914 (+30%) 33,816 (+37%)

股票期權 (每月和每周) 943,225 (+31%) 13,818,184 (+26%)

截至  2025年4月30日
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截至  2025年4月30日

恒生科技指数期货、期权及期货期权表现
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数据来源：香港交易所、彭博资讯
* 不包括佣金, 交易所提供每张合约HK$2.5的50%交易费用优惠(标准交易费用为每张合约HK$5.0)

资料只供参考

成交量及未平仓合约持续增长为投资者提供一种工具来管理其香港上市科技股仓位的风险

未平仓合约 (截至2025年4月30日)恒生科技指数

恒生科技指数期货及期权及实物交收期货期权

 合约乘数 每指数点50港元

 名义金额 (1张合约) 25.4 万港元 (于2025年4月30日)

 流通量提供者数目 不適用

证券交易费用*

 印花税 不适用

 交易费用 HK$2.50 / 合约

 证监会徵费 HK$0.54 / 合约

 指数简介 追踪于香港上市的最大型的科技公司

平均每日 (截至2025年4月)
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MSCI中国A50互联互通指数期货表现
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数据来源：香港交易所、彭博资讯
* 不包括佣金, 交易所提供每张合约US$0.5的50%交易费用优惠(标准交易费用为每张合约US$1.0)

资料只供参考

多元化中国投资组合的风险管理工具均衡把握中国A股市场机会

 MSCI 中国 A50 互联互通指数

 反映首50只具代表性及均衡性的11个行业

 的中国A股

 指数值  2,055.27 (于2025年4月30日)

 指数历史波幅 (30日)  24.2

 指数日均幅度  19.77 (2025年4月)

 与沪深300指数关连性 (2025)  0.974

 与富时中国A50指数关连性 (2025)  0.976

 合约乘数  每指数点25美元

 名义金额 (1张合约)  5 万美元 (于2025年4月30日)

 平均开价盘单位  26 万美元 (5张合约)

 证券交易费用*

 印花税  不适用

 交易费用  US$0.50 / 合約

 证监会徵费  US$0.07 / 合約

 保证金 (截至1900年1月0日)  US$3,740

 MSCI 中国 A50 互联互通指数期货

 指数简介
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MSCI 亚洲及新兴市场指数期货表现
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数据来源：香港交易所、彭博资讯
* 不包括佣金
资料只供参考

成交量及未平仓合约持续增长香港交易所为亚洲时区内拥有最多元化MSCI衍生工具的交易所
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MSCI 亚洲及新兴市场指数

MSCI 亚洲及新兴市场指数期货

 合约乘数 每指数点平均40美元

 名义金额 (1张合约) 平均5.4 万美元 (于2025年4月30日)

 流通量提供者数目 12

证券交易费用*

 印花税 不适用

 交易费用 US$0.6-US$1.0 / 合约

 证监会徵费 US$0.07 / 合约

 指数简介 涵盖38只已发展及新兴城市及地域指数

未平仓合约 (截至 2025年4月30日)

每日平均成交量 (截至 2025年4月)

截至  2025年4月30日



MSCI亚洲除日本净总回报指数期货表现
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数据来源：香港交易所、彭博资讯
* 不包括佣金，所有数据以美元结算
资料只供参考

MSCI亚洲除日本指数涵盖已发展及新兴市场 (重设基数= 100)

MSCI亚洲除日本指数是追踪亚洲（日本除外）
股票市场表现的成熟指标

期货买卖成本较低

未平倉合約 (截至 2025年4月30日) MSCI亚洲除日本净总回报指数

 10只最大及最具代表性的香港上市中国内地

 银行股

 指数值  593.25 (于2025年4月30日)

 指数历史波幅 (30日)  33.8

 指数日均幅度  8.36 (2025年4月)

 与恒生指数关连性 (2025)  0.866

 与国企指数关连性 (2025)  0.834

 合约乘数  每指数点100美元

 名义金额 (1张合约)  5.9 万美元 (于2025年4月30日)

 平均开价盘单位  30 万美元 (5张合约)

 平均买卖差价  1.7 指数点 (2025年4月)

 流通量提供者  Flow 与11间银行

 印花税  不适用

 交易费用  US$0.5 / 合约

 证监会徵费  US$0.07 / 合约

 保证金 (截至2025年4月28日)  US$4,610

 MSCI亚洲除日本净总回报指数期货

 指数简介
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截至  2025年4月30日

恒生中国内地银行指数期货表现
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数据来源：香港交易所、恒生指数有限公司、彭博资讯
* 不包括佣金，所有数据以港币结算
资料只供参考

指数及成份股过往三个月表现 (重设基数= 100)

内银指数期货可作投资对冲期货买卖成本较低

每五分鐘平均買賣差價比較 (2025年4月30日) 恒生中国内地银行指数(内银指数)

 10只最大及最具代表性的香港上市中国内地

 银行股

 指数值  3,457.10 (于2025年4月30日)

 指数历史波幅 (30日)  34.3

 指数日均幅度  54.11 (2025年4月)

 与恒生指数关连性 (2025)  0.826

 与国企指数关连性 (2025)  0.838

 合约乘数  每指数点50港元

 名义金额 (1张合约)  17 万港元 (于2025年4月30日)

 平均开价盘单位  86 万港元 (5张合约)

 平均买卖差价  不适用

 流通量提供者  不适用

 印花税  不适用

 交易费用  HK$2 / 合约

 证监会徵费  HK$0.54 / 合约

 保证金 (截至2025年4月28日)  HK$9,410

 恒生中国内地银行指数期货

 指数简介

 证券交易费用*

0.18%

0.18%

0.20%

0.23%

0.23%

0.23%

0.24%

0.35%

0.38%

0.57%

N/A

招商银行 3968.HK

中信银行 998.HK

工商银行 1398.HK

农业银行 1288.HK

建设银行 939.HK

中国银行 3988.HK

邮储银行 1658.HK

交通银行 3328.HK

民生银行 1988.HK

中国光大银行6818.HK

内银指数期货
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中华120指数期货表现
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数据来源：香港交易所、恒生指数有限公司、彭博资讯
* 不包括佣金，所有数据以港币结算
资料只供参考

指数及成份股过往三个月表现 (重设基数= 100)

中华120指数期货可作投资对冲期货买卖成本较低

每五分鐘平均買賣差價比較 (2025年4月30日)

截至  2025年4月30日

 中华120指数(中华120)

 80只A股及40只香港上市中资股(H股、 民企

 股及红筹股)

 指数值  6,292.81 (于2025年4月30日)

 指数历史波幅 (30日)  37.0

 指数日均幅度  84.89 (2025年4月)

 与沪深300指数关连性 (2025)  0.899

 与富时中国A50指数关连性 (2025)  0.877

 合约乘数  每指数点50港元

 名义金额 (1张合约)  31 万港元 (于2025年4月30日)

 平均开价盘单位  157 万港元 (5张合约)

 平均买卖差价  不适用

 流通量提供者  不适用

 印花税  不适用

 交易费用  HK$2 / 合约

 证监会徵费  HK$0.54 / 合约

 保证金 (截至2025年4月28日)  HK$16,580

 中华120指数期货

 指数简介

 证券交易费用*

0.17%

0.18%

0.19%

N/A

华夏沪深300 ETF (3188.HK)

X安硕A50中国 ETF (2823.HK)

南方中国A50 ETF (2822.HK)
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旗舰期货 –合约细则
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数据来源：香港交易所

项目 恒生指数期货 恒生中国企业指数期货 恒生科技指数期货

相关指数 恒生指数 恒生中国企业指数 恒生科技指数

HKATS代码 HSI HHI HTI

合约乘数 每指数点50港元

最低价格波幅 一个指数点

合约月份
短期期货: 现月、下三个月及之后三个季月; 及

远期期货: 再之后三个6月及12月，另加之后三个12月
短期期货: 现月、下三个月及之后三个季月;及

远期期货: 再之后三个6月及12月

开市前时段 上午8时45分至上午9时15分及中午12时30分至下午1时正

交易时间
上午9时15分至中午12时正，下午1时正至下午4时30分及下午5时15分至凌晨3时正

(到期合约月份在最后交易日收市时间为下午4时正)

最后交易日 合约月份的倒数第二个交易日

最后结算价 在最后交易日当天每隔五分钟所报的指数点的平均数

交易费用 10.00港元 3.50港元 5.00港元



旗舰期权 –合约细则
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数据来源：香港交易所

项目 恒生指数期权 恒生中国企业指数期权 恒生科技指数期权

相关指数 恒生指数 恒生中国企业指数 恒生科技指数

HKATS代码
月份合约: HSI

周份合约: “HSI” + 行使价 + 合约月份 + 合
约年份 + “W” + 到期日

月份合约: HHI

周份合约: “HHI” + 行使价 + 合约月份 + 

合约年份 + “W” + 到期日
HTI

合约乘数 每指数点50港元

最低价格波幅 一个指数点

合约月份 / 

合约周份

月份合约
短期期货: 现月、下三个月及之后三个季月; 及

远期期货: 再之后三个6月及12月，另加之后三个12月

周份合约
现周及下周，除非每周合约的到期日与现月指数期权

合约的到期日相同

月份合约
短期期货: 现月、下三个月及之后三个季月; 及

远期期货: 再之后三个6月及12月

行使方式 欧式期权

期权金 以完整指数点报价

行使价

指数点 行使价间距 指数点 行使价间距

短期期权 (月份及周份合约): 长期期权 (月份合约):

≥ 20,000 200 ≥ 20,000 400

≥ 5,000 and < 20,000 100 ≥ 5,000 and < 20,000 200

< 5,000 50 < 5,000 100

交易时间
上午9时15分至中午12时正，下午1时正至下午4时30分及下午5时15分至凌晨3时正

(到期合约月份在到期日收市时间为下午4时正)

到期日
合约月份的倒数第二个交易日 (月份合约)

合约周份的最后交易日 (周份合约)

正式结算价 在到期日当天每隔五分钟所报的指数点的平均数

交易费用 10.00港元 3.50港元 5.00港元



旗舰期货期权(实物交收) –合约细则
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数据来源：香港交易所

项目 恒生指数期货期权(实物交收) 恒生中国企业指数期货期权(实物交收) 恒生科技指数期货期权(实物交收)

相关指数 恒生指数期货 恒生中国企业指数期货 恒生科技指数期货

HKATS代码 PHS PHH PTE

合约乘数 每指数点50港元

最低价格波幅 一个指数点

合约月份
短期期货: 现月、下三个月及之后三个季月; 及

远期期货: 再之后三个6月及12月，另加之后三个12月
短期期货: 现月、下三个月及之后三个季月; 及

远期期货: 再之后三个6月及12月

行使方式 欧式期权

期权金 以完整指数点报价

行使价

指数点 行使价间距 指数点 行使价间距

短期期权: 长期期权:

≥ 20,000 200 ≥ 20,000 400

≥ 5,000 and < 20,000 100 ≥ 5,000 and < 20,000 200

< 5,000 50 < 5,000 100

交易时间
上午9时15分至中午12时正，下午1时正至下午4时30分及下午5时15分至凌晨3时正

(到期合约月份在到期日收市时间为下午4时正)

到期日 合约月份的第三个星期五

行使时的结算 实物交收。所有价内期权在到期时自动行权

正式结算价 采用到期日当天相应合约月份的指数期货于下午 3:55 至 4:00 期间每隔五秒钟所报的指数期货价格的平均数

交易费用 10.00港元 3.50港元 5.00港元



恒生科技指数期货及期权的讯息代码
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数据来源：香港交易所

资讯供应商 恒生科技指数期货 恒生科技指数期权

阿斯达克 221014 322400

ACTIV Financial HTI/<yy><m>.HF HTI/<yy><mm>/<strike><t>.HF

彭博 HCTA Index HSTECH Index OMON

Colt Technology HTImy HTI<Strikes>my

财经智珠网 HTI HTI

大智慧 HTI

东方财富资讯 HTI

易盛信息 HTI HTI

经济通 HTI HTI

同花顺 HTI HTI

汇港资讯 HTI HTI

联盛亚富 870840 873201-7

钱龙 229

路孚特 0#HHTI 0#HTI*.HF

上海澎博 HTI + Month Code

文华财经 HTI HTI

万得信息 HTIF.HK HTIO.HK



MSCI中国A50互联互通指数期货的讯息代码
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数据来源：香港交易所

资讯供应商 MSCI中国A50互联互通指数期货

阿斯达克 221790

ACTIV Financial MCA/<yy><m>.HF

彭博 MCYA Index

Colt Technology MCAmy

东方财富资讯 MCA

易盛信息 MCA

经济通 MCA

汇港资讯 MCA

联盛亚富 870939

路孚特 0#HMCA:

SIX Financial MCAmy

万得信息 MCAF.HK



MSCI 亚洲及新兴市场指数期货的讯息代码
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数据来源：香港交易所

资讯供应商

MSCI澳洲净总
回报(美元)指数
期货

MSCI中国A50互
联互通(美元)指数
期货

MSCI中国(美元)

指数期货
MSCI中国净总回
报(美元)指数期货

MSCI 新兴市场亚
洲除中国净总回
报（美元）指数
期货

MSCI 新兴市场亚
洲除韩国净总回
报（美元）指数
期货

MSCI 新兴市场亚
洲净总回报（美
元）指数期货

MSCI 新兴市场欧
非中东净总回报
（美元）指数期
货

MSCI 新兴市场除
中国净总回报
（美元）指数期
货

彭博资讯 HKCA Index MCYA Index CSIA Index CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index

路孚特 0#HMAN: 0#HMCA: 0#HCHI: 0#HCHN: 0#HMAC: 0#HMAK: 0#HEAN: 0#HMEE: 0#HMXC:

万得 MANF.HK MCAF.HK EANF.HK

资讯供应商

MSCI 新兴市场
除韩国净总回报
（美元）指数期
货

MSCI 新兴市场
拉丁美洲净总回
报（美元）指数
期货

MSCI 新兴市场
（美元）指数期
货

MSCI 新兴市场
净总回报（美元）
指数期货

MSCI 香港净总
回报（美元）指
数期货

MSCI 印度（美
元）指数期货

MSCI 印度净总
回报（美元）指
数期货

MSCI 印尼（美
元）指数期货

MSCI 印尼净总
回报（美元）指
数期货

MSCI 日本（日
元）指数期货

彭博资讯 HQIA Index HQYA Index HMPA Index HMOA Index HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index

路孚特 0#HMXK: 0#HMEL: 0#HMEM: 0#HEMN: 0#HMHN: 0#HMDA: 0#HMIN: 0#HMID: 0#HMDN: 0#HMJP:

万得 MINF.HK MDNF.HK

资讯供应商

MSCI 日本净总
回报（日元）指
数期货

MSCI 日本净总
回报（美元）指
数期货

MSCI 马来西亚
（美元）指数期
货

MSCI 马来西亚
净总回报（美元）
指数期货

MSCI 新西兰净
总回报（美元）
指数期货

MSCI 太平洋除
日本净总回报
（美元）指数期
货

MSCI 太平洋净
总回报（美元）
指数期货

MSCI 菲律宾
（美元）指数期
货

MSCI 菲律宾净
总回报（美元）
指数期货

MSCI 新加坡自
由（新加坡元）
指数期货

彭博资讯 HQBA Index HJCA Index HMYA Index HKEA Index HOPA Index HRPA Index HRBA Index HNSA Index HLEA Index HKOA Index

路孚特 0#HMJJ: 0#HMJU: 0#HMMY: 0#HMMN: 0#HMNZ: 0#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: 0#HMSG:

万得 MJUF.HK MMNF.HK

资讯供应商

MSCI 新加坡自
由净总回报（美
元）指数期货

MSCI 新加坡净
总回报（美元）
指数期货

MSCI 台湾（美
元）指数期货

MSCI 台湾
25/50（美元）
指数期货

MSCI 台湾
25/50 净总回报
（美元）指数期
货

MSCI 台湾净总
回报（美元）指
数期货

MSCI 泰国（美
元）指数期货

MSCI 泰国净总
回报（美元）指
数期货

MSCI 越南（美
元）指数期货

MSCI 越南净总
回报（美元）指
数期货

彭博资讯 HOBA Index HKPA Index HJAA Index HRCA Index HRDA Index HJBA Index HMTA Index HKDA Index HNTA Index HKSA Index

路孚特 0#HMGN: 0#HMSN: 0#HMTW: 0#HTWP: 0#HTWN: 0#HMWN: 0#HMTH: 0#HMTN: 0#HMVT: 0#HMVN:

万得 MTWF.HK MWNF.HK MTNF.HK



每周恒指及国企指数期权的讯息代码
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数据来源：香港交易所

MSCI亚洲除日本净总回报指数及其期货的讯息代码

香港及国际资讯供应商

资讯供应商 MSCI亚洲除日本净总回报指数 MSCI亚洲除日本净总回报指数期货

阿斯达克财经网 322105 322125

彭博资讯 HSI Index OMON HSCEI Index OMON

财经智珠网 HSI HHI

经济通 Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name

汇港资讯 HSI HHI

天汇财经 HSI HHI

N2N-AFE 873101 873121

路孚特 <0#HSIW*.HF> <0#HCEIW*.HF>

捷利资讯 File->Open->Options->HSI File->Open->Options->HHI

捷利资讯 - MXJFC, MXJmyy

香港及国际资讯供应商

资讯供应商 MSCI亚洲除日本净总回报指数 MSCI亚洲除日本净总回报指数期货

阿斯达克财经网 - 221495

Activ Financial - MXJ/<yy><m>.HF

彭博资讯 M1ASJ Index MJSA Index CT

CQG - MXJ

财经智珠网 - MXJ

东方财富资讯 - MXJ

Factset - MXJE

ICE Data Services - F:MXJ

汇港资讯 - MXJ

联盛亚富资讯 - 870823

QPWeb - P11203

SIX Fin Information - MXJmy

路孚特 .MIAX00000NUS 0#HMXJ:

电资讯 - MXJ/<yy><m>.HF

捷利资讯 - MXJFC, MXJmyy



行业指数及行业指数期货的讯息代码
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数据来源：香港交易所

资讯供应商 内银指数 内银指数期货

AASTOCKS 221420

Activ Financial =0200700.HK MBI/16K.HF

亚富资讯科技 837451 870809

彭博资讯 HSMBI Index BMWA Index

DB Power MBI

经济通 MBN MBI

汇港资讯 HSMBI MBI

报价王 SEHK.HHSMBI P11223

电资讯国际有限公司 MBImy

路孚特 .HSMBI 0#HMBI:

香港及国际资讯供应商

中国内地资讯供应商

资讯供应商 内银指数 内银指数期货

东方财富 HSMBI MBI

同花顺 MBIC

上海澎博财经
MBI+Month+Yea

r

上海乾隆 999905 209

万得 HSMBI
MBIF+yymm+H

K



中华120 及中华120 期货的讯息代码
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数据来源：香港交易所

资讯供应商 中华120 中华120 期货

彭博资讯 CES120 CESA Index DES <GO>

路孚特 .HKCES120 0#HCHH:

AAStocks 110056 221360

亚富资讯科技 837505 870800

DB Power CES120 CHH

经济通 CEC CHH

汇港资讯 CE120 CHH

Interactive Data Group I:CES120 Fn:CHH\MYYDD

Marketprizm Hong Kong Limited CES120 CHHmy

SIX Financial Information Ltd. CES120 CHHmy

电资讯国际有限公司 CES120 CHHmy

香港及国际资讯供应商

中国内地资讯供应商

资讯供应商 中华120 中华120 期货

同花顺 CES120 CHHC

大智慧 CES120 CHH+Month Code+Year Code

恒生聚源 CES120 -

万得 CES120 CHHF+yymm+.HK

易盛信资讯 - CHH

文华财经 - CHHmy

上海乾隆 CES120 Page 209
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